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Chapter 1 Working with Excel Templates 

 What is a Template? 

A template is a workbook design or layout that can be saved and reused for any number of workbooks. 
A template can have formulas, fill effects, labels, borders, worksheet names, formats and a host of other 
Excel features that will be applied to each new workbook using the template. 

 

I. Opening a Template 
To open a workbook using a template: 

1. Choose the New option from the Office menu.  
 

 
 

2. Select a template category. 
3. A list of templates relating to the category are available. 
4. Double-click on a template icon. A workbook will open based on the selected template. 

 

II. Using a Template 
To use a template: 

1. Click on the File menu and select New to find a template. The Personal tab will show 
all personal templates.  

2. Once the workbook is open, the formatting and organization of data will all be in 
place based on the template.  

3. Enter data into the spreadsheet as required 
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III. Creating a Template 
To create a template: 

1. Design the worksheet or workbook layout to meet any specifications required. 
2. Layouts can be different for sheets in the workbook as a template can contain as many 

worksheets as needed. 
3. Plan the layout, labels and formats to make the template. 
4. Choose Save As from the Office menu to display the Save As dialogue box.  
5. Enter a name for the template in the File Name text field.  
6. Next, display the Save As Type drop list near the bottom of the dialogue box and select 

the Excel template option. 
7. This will save the file as filename.xltx.  
8. The new template will be automatically saved in the Excel Templates folder. 
9. Once the template has been saved as a template in the Templates folder, it will be 

available under the Personal option in the New window.  
 

Rather than create a template from scratch, download a template that is similar to the desired 
template and modify it in Excel. Once the template is complete, save it with a new name in the 
templates folder. Remember to save it as a template rather than a workbook. 
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Chapter 2 Working with Tables 

 What is a Table? 

In Excel, a table is a specially designated range of numbers. This special range of numbers has added 
functionality that other cell ranges do not have. There can be more than one table in a workbook at a 
time and tables can be as large or small as the amount of data in them. 

 
Normally, a table is made from adjacent columns of data, with a unique label or heading for each 
column. Each row in the table should have entries organized according to the column headings. 
Remember, that Excel has a lot more rows than columns. This design is well suited for data organized in 
long, adjacent, list-like columns. A table can be made with empty rows or columns, but this is not 
recommended. Data should be kept adjacent in a block to take advantage of all of Excel’s table features. 

 

 
 

I. Creating Tables 
To create a table from an existing range: 

1. Select a range of data in adjacent columns. 
2. Click on the Format as Table button in the Home Ribbon. 

 

3. Select a table menu option and the selected range will be formatted as a table based on 
the style. 

4. A Format as Table dialogue box appears. 
5. Check the My table has heaers checkbox if there are column 

headings in the first row of the range the table selected. 
6. Make sure the cell range identified is the range for the table. 
7. Press OK. 
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To create a table from scratch: 
1. Enter column labels for the data across the top row.  
2. A table can be created based on just the column labels by selecting the cells containing 

the labels and clicking the Format as Table button on the Home Ribbon.  
3. Next, select a table style from the drop down menu and the Format as Table dialogue 

will appear.  
4. When the Format as Table dialogue box appears, ensure that the row of labels has been 

selected properly. Check the My list has headers checkbox before clicking OK. 
5. Enter data as usual into the cells of the table created. 

 

II. Modifying Tables 
To resize a table: 

1. At the bottom right corner of the table, there is 
a small blue move handle. 

2. Place the mouse pointer on the move handle. It 
will turn into a double headed arrow.  

3. Hold down the left mouse button and drag the 
move handle to resize the list.  

4. Drag downward to add more rows or drag to 
the right to add more columns to the table. 

 
 
Another way to resize a table: 

1. Click on a cell in the table. 
2. A Design tab will appear above the ribbon area of the screen.  
3. Near the bottom of the Properties group. Click the Resize Table button. 
4. The table will be enhanced by a dashed flashing border and the Resize Table dialogue 

box will appear. 

 

5. A new range can be entered directly into the range field of the resize table dialogue or 
select a range with the mouse and it will be entered automatically. 
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III. What is a Total Row 
When working with a table in Excel, click on a table cell, to 
access the Design tab. In the Design Ribbon, there is a check 
box in the Table Style Options button group labeled Total 
Row. 
 
Clicking on this checkbox will display another row at the 
bottom of the table with the word Total in the first cell. The Totals Row can also be shown by 
right clicking a cell in the table and choosing the Totals Row option from the Table sub menu. 

 

When a cell in the total row is selected, an arrow will indicate a drop-down list. 
 

 

The drop-down list has a number of options. 

None Shows nothing in the total row for this column. 

Average Shows the average of numerical values for the column. 

Count  Shows the number of items in the column. 

Max  Displays the maximum item for the column. 

Min  Displays the minimum item for the column. 

Sum  Displays the sum of numerical data in the column. 

StdDev  Shows the standard deviation for numerical column data. 

Var  Shows the variance of numerical data in the column. 
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Each cell in the total row can be selected and an option from the drop-down list can be applied 
to the selected cells. 

 
In the following example, the total row shows a count of the Account numbers (8) and the 
average of the Balances ($32408.75). 

 

To change what is displayed in the total row, click on any cell in the row and choose a different 
option from the drop list to design the total row. The total row can be hidden by clearing the 
Total Row checkbox on the Design Ribbon, or by right clicking a cell in the table and choosing 
Totals Row from the Tables sub menu. 
 

IV. Moving and Copying Sheets 
Sheets in a workbook can be rearranged by moving them. Sheets can also be moved onto 
another sheet. Copying sheets within a workbook or into another workbook is also possible. The 
Cut, Copy and Paste commands cannot be used to move or copy entire sheets. 
 
To copy a sheet within a workbook: 

1. Select the sheet to copy. 
2. Press Ctrl then click and drag the sheet to the position to copy to. 

 
Note: A new sheet is given a sub-number.  For example when Sheet5 is copied the new sheet 

is Sheet 5 (2) or when January is copied the new sheet is January (2). 
 
To move a sheet within a workbook: 

1. Select the sheet to copy. 
2. Click and drag the sheet to the new location. 

 
Note: Multiple sheets can be copied/moved by selecting a group of sheets before executing 

the copy or move commands. 
 

To copy a sheet into another workbook: 
1. Open the files to copy the sheet(s) to and from. 
2. Right-click the sheet(s) to copy. 
3. Choose Move or Copy. 
4. In the To Book box chose the Filename of the workbook for the sheet(s) to be copied to. 
5. Select Create a copy at the bottom of the dialog box. 
6. Press OK. 
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To move a sheet into another workbook: 
1. Open the files to move the sheet(s) to and from. 
2. Right-click the sheet(s) to move. 
3. Choose Move or Copy. 
4. In the To Book box chose the Filename of the workbook for the sheet(s) to be moved to. 
5. Press OK. 

 

 What is a Pivot Table? 

A Pivot Table is an interactive table used to quickly manipulate and summarize data. Using simple drag 
and drop actions, rows and columns can be rotated to create summaries of the source data, filter the 
source data and examine data in further detail. 

 

I. Creating a Pivot Table 
To create a Pivot Table, first ensure the source data is clean and organized. Columns and rows 
should be labeled and no blank rows or columns should be present in the selection. 

 
 

To create a Pivot Table: 
1. From the Insert tab, under the Tables section, click the Pivot Table button to open the 

Pivot Table dialog window. 
2. Select the table or range for the pivot table and its location in the worksheet. 
3. Click OK to insert the pivot table. 

 
Note: The pivot table tools tabs will now display on the ribbon. A pivot table graphic 

placeholder will appear on the sheet and the pivot table field list will display to the right 
of the screen. Selecting fields to add to the report will automatically change the Pivot 
Table placeholder graphic with the selected datsa. 
 

4. In the field list, select the fields to include in the Pivot Table report. 
5. Arrange the look of the report by dragging the corresponding fields, such as Team and 

Salary into the appropriate report categories. 
6. The Pivot Table will automatically update. 

 



12 | P a g e  Excel Level 2 • 2018 University of Regina 

 
 
 

Pivot Table Settings 
 

Result of the Pivot Table 
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Chapter 3 Working with Names and Ranges 

 Naming Ranges 

Cell references like D5:D22 or A33:C33 are somewhat abstract and don’t really communicate anything 
about the data they contain. In Excel, cells or ranges can be given names for easy reference. 

 

I. What are Range Names? 
Range names are meaningful character strings that are assigned to 
individual cells or cell ranges. A range name can be used anywhere a 
cell or range is referenced. The advantage of using names comes 
from the fact that a name, like Employees, is more meaningful and 
less abstract than a reference like C2:C55. Also, named ranges are by 
default absolute. If a range is copied, it will maintain its original cell 
references.  

 
Range names make formulas more readable and make it easier to find and reference individual 
cells. Using range names in a worksheet improves clarity, improves organization and aids in the 
overall design.  
 

II. Defining and Using Range Names 
To define a range name: 

1. Select either a cell or cell range and choose the Define 
Name button from the Formulas Ribbon. 

2. This will display the New Name dialogue box. 
3. In the New Name box is the reference to the cell or range 

selected in the bottom text field.  
4. Enter a name for the range in the top text field and click 

OK. (A comment to be associated with the new named 
range can also be added at this time.)  

5. The Scope refers to the parts of the workbook where the named range will be valid. 
 
Another way to name a cell or range is: 

1. Select the range. 
2. Enter the name in the name box on the formula bar 

and press Enter. 
3. Press the down pointing arrow to the right of the 

name box to see a list of range names used in the 
spreadsheet. 
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Excel does not accept spaces between words in the names chosen. For example, “newrange” or 
“newRange” is acceptable, but “New Range” is not. 

 
Once a name range has been defined, it can be used in formulas and functions just like a regular 
cell or range reference.  

 
Using names for ranges and cells in this way makes formulas and functions much clearer. It is 
much easier to enter the name range into for a formula or function rather than the specified cell 
references. 
 

III. Selecting Non-Adjacent Ranges 
To select non adjacent ranges: 

1. Press and hold the Ctrl button and select the first range.  
2. Keep holding the Ctrl button and select each additional non adjacent range or cell with 

the mouse.  
3. The normal rules of mouse dragging to select a range and clicking to select cells apply. 

 
Format multiple selections all at once by clicking a formatting button on the Home Ribbon, or 
give them a defined name. 
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Chapter 4 Working with Functions and Formulas  

 Using Functions in Excel 

I. Inserting Functions 
To insert a function: 

1. Choose a cell to contain the function result.  
2. Display the Insert Function dialogue box by clicking the fx button next to the formula bar 

or choose the Insert Function button from the Formulas Ribbon. 
 

 
 

3. In the Insert Function dialogue box, select functions by category via a drop down list.  
 

 
 

 
4. Once a function is chosen, click OK to move to the next step: the Function Arguments 

box. 
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For this example the PMT function has been selected from the financial category. The PMT 
function will calculate the payment amount for a loan based on the arguments provided. 
 

 
 

 In the upper part of the box, there is a series of text fields, one for each possible 
argument to the function. Click on an argument field to see a brief description of the 
argument at the bottom of the dialogue box.  

 The argument names are to the left of the argument fields.  

 The ones in bold type (Rate, Nper, and Pv) are required arguments. 

 For arguments without bold type names, Excel 2007 will enter a default value when 
required if the argument fields are left empty. 

 
Raw data can be entered directly onto the argument fields or, if the data is stored in the 
worksheet, type the appropriate cell references. It is also possible to click on an argument field 
and then select the cell that contains the data to enter it without typing.  
 
This process allows functions to be inserted into a worksheet without having to manually type 
them. 

 
By using the Insert Function feature, parentheses and commas are not an issue. Also, the 
arguments descriptions is visible and how many arguments are required.  

 
 

II. Using the IF Function 
Excel’s IF function can be very useful. This function can be used to branch to different values or 
actions depending on a specified condition. The structure of an If function is as follows: IF 
(logical test, value if true, value if false)  
 
IF functions are called conditional functions because the value that the function returns will 
depend on whether or not a specific condition is satisfied. As an example, consider the following 
function: IF (A1=10, 5, 1)  
 
This function states that if cell A1 has a value of 10 the cell that contains the function will have 
the value of 5. But if A1 doesn’t have a value of 10, the cell that contains the function will have a 
value of 1. In other words, the function reads: if A1 equals 10 then return the number 5, else, 
return the number 1. 
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III. Working with Nested Functions 
In Excel,  functions can be placed (nested) within a function. Look at the following worksheet as 
an example. 
 

 
 
By looking in the formula bar, the average function for cell E7 contains three sum functions (the 
sums of the three type columns). This means that the value in E7 is the average of the sums of 
columns B, C and D. 
 
This IF function has two additional IF functions nested inside.  
 
=IF(A1<100, A1*1.5,IF(A1<200, A1*2,IF(A1<300, A1*2.5,A1*3))) 
 
The first IF tests to see whether the value in cell A1 is less than 100. If it is, the result of this 
function will be the value of A1 multiplied by 1.5. If the value in A1 is equal to or greater than 
100, the test condition will be false, and the second value will come into play. In this case, the 
second value is a nested IF function that tests whether the value in A1 is less than 200. If it is, 
the value in A1 is multiplied by 2 will be the result of the function. If the value in A1 is greater 
than or equal to 200 the third IF function will be used. This function tests whether the value in 
A1 is less than 300. The value in A1 will be multiplied by 2.5 if it is less than 300 or multiplied by 
3 if it is greater than or equal to 300.  
 
Remember, when nesting functions always make sure that there are as many closing 
parentheses as there are opening parentheses. 
 
Note:  Excel will permit up to 64 levels of nested functions. Previous versions of Excel only 

supported 7 levels of nested functions. Also, Excel will support 255 arguments to a 
function, where previous versions of Excel only supported a maximum of 30 function 
arguments. 
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 Working with Array Formulas 

I. What Are Array Formulas? 
An array is a grouping of two or more cells. If a selection of empty cells is made on a worksheet, 
type some text or a number in one of the cells and press Ctrl + Shift + Enter at the same time, 
the value just typed will in appear in every cell in the selection. When Ctrl + Shift + Enter is 
pressed, Excel will treat the selection as a single entity or array. When a selection is defined as 
an array, operations are performed on every cell in the selection rather than on just a single cell. 
Operations involving corresponding cells in a number of ranges using array formulas. This is a 
powerful technique that can be used to enhance Excel formulas and functions.  
 
If a formula involving selections of multiple cells is entered Ctrl + Shift + Enter is pressed, Excel 
will automatically place curly braces { } around the formula. This means that Excel will treat this 
formula as an array formula.  
 
Note that curly braces cannot be typed manually to create array formulas: they must be created 
by pressing Ctrl + Shift + Enter. Some people even refer to array formulas as CSE (Control Shift 
Enter) formulas. 
 

 
 

II. Using Basic Array Formulas 
Using array formulas is fairly straightforward once the basic concepts are understood. The 
important thing to remember is that arrays of the same size should be selected to use in array 
formulas (same number of rows and columns). Array formulas that involve cell ranges (arrays) of 
different sizes will not work.  
 
In the following example we have two columns of numbers, F2:F16 and G2:G16. Note that both 
columns of numbers are the same size. A third column can be selected of the same size, type the 
formula =F2:F16*G2:G16, and press Ctrl + Shift + Enter. 
 

 



 

University of Regina Excel Level 2 • 2018 P a g e  | 19 

 
Each cell in the first column will be multiplied by the corresponding cell in the second column, 
with the result being displayed in the third column. 
 
Take note of the curly braces around the formula displayed in the formula bar. If Enter was 
pressed, the curly braces would not be added, and Excel would not recognize the ranges as 
arrays. As a result, only the value of the first two cells multiplied together, 4840, would be 
displayed in the cell G2. 
 
When entering formulas into the formula bar, it is possible to select the ranges in the formula 
with the mouse rather than typing them directly.  
 
 

III. Using Functions with Array Formulas 
Suppose you want to take the average or sum of a large block of numbers after every number in 
the block has been multiplied by a constant. This can be done by combining functions and arrays 
to perform this kind of operation.  
 
To combine functions and arrays: 

1. Select a single cell for the result of the function (assuming the function will return a 
single result).  

2. Enter the function and select the cell ranges needed.  
3. Press Ctrl + Shift + Enter. 

 
As an example, the worksheet on the following page calculates the average area of a circle 
based on a table of many cells, each containing a number representing the radius of a circle. The 
area of a circle can be calculated by multiplying the square of the radius by the mathematical 
constant PI. The formula reads: {=AVERAGE(C2:F15^2*PI ())} 
 
In this formula, C2:F15 is the range of cells containing the data. The ^2 raises each cell value 
(radius) to the second power. The * PI () part multiplies the squared radius with the Excel PI 
function. The AVERAGE function calculates an average result. Finally, the curly braces { } enclose 
the entire function, letting Excel know that this formula involves an array, and that the 
mathematical operations are to be performed on each cell in the specified range.  
 
The result of all this is that each and every number in the range C2:F10 will be squared and 
multiplied by PI and then averaged together for a final result.  
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The formula for cell H2 can be seen in the formula bar. The formula uses the AVERAGE function, 
a calculation involving a nested PI function [^2*PI ()], and is enclosed in { }, making it an array 
formula. (Note: The parentheses are required after the text PI for Excel to recognize it as the PI 
function.)  
 
Array formulas can perform mathematical or logical operations with corresponding cells in two 
or more ranges of the same size. Additionally, array formulas can perform mathematical or 
logical operations on every cell in a selected range. Array formulas and functions can be 
combined together to solve awkward problems. As a matter of fact, there are times when using 
array formulas may be the only solution for a tricky situation.  
 
 

IV. Using the IF Function in Array Formulas 
A very interesting and useful way of working with array formulas, is to combine them with 
Excel’s IF function. Remember, the IF function works like this:  
 
IF (test condition, value if test is true, value if test is false) 
 
Now suppose we use ranges of cells (arrays) instead of individual cells. 
 
=IF(B4:B14=C4:C14, B4:B14, 0) 
 
If we make this an array formula (Ctrl + Shift +Enter), the IF function will return the value in the 
B4:B14 array whenever that value is equal to the corresponding value in the C4:C14 array. When 
the values are not equal, zero will be returned.  
 
The next step is to combine this with a Sum function in the following way. 
 
{=Sum(IF(B4:B14=C4:C14,B4:B14,0))} 
 
If we make this an array formula, the function will basically step through both ranges (arrays) 
row by row, and sum the values that are returned from the IF function. 
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The values returned from the If function are 0, 0, 0, 4, 5, 0, 0, 0, 4, 12, 0, for a result of 25. 
(The array formula for the active cell can be seen in the formula bar). 
 
As another example of what can be done with array formulas, suppose we have a worksheet like 
the following. 
 

 
 
To find out how many hours Janet worked, the following array formula could be created. 
 
{=SUM(IF(A2:A11="Janet",C2:C11,0))} 
 
This formula will step through the arrays A2:A11 and C2:C11, returning the value in C2:C11 
every time the name in A2:A11 equals Janet, and zero otherwise. The returned values will be 
summed in cell F2 for a total of 18. 

 
Note:  When working with array formulas, keep in mind that operations on very large cell 

selections (arrays) might take longer than expected. Array formulas involving large 
arrays can increase the time it takes to recalculate the worksheet.  
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Chapter 5 File Formats 

 Files 

I. Saving Files 
For Excel, the basic file format extensions are: 

.xlsx  Signifies an Excel workbook. 

.xltx Signifies an Excel template. 

.xlsb Signifies an Excel binary workbook. 

.xlam Signifies an Excel add-in.  

Any of these file types will open fine in Excel. However, to open these file types with an earlier 
version of Excel (like Excel 2003 or Excel 2000), a problem occurs. Office uses a new file format 
that promotes interoperability between programs. However, the new file format may not be 
compatible with earlier versions of Microsoft Office software. 
 
If the document is going to be opened in an earlier version of Excel, the file can be saved as an 
Excel 97-2003 workbook. 
 
The save as dialogue: 

1. In Excel, use the Save As dialogue to choose where to save the file and the file type. 
2. Click Browse to browse to the location to save to, as well as the option of the file type. 
3. The drop-down list labeled Save As Type allows for a format to be chosen for saving the 

file. 
 

Understanding file formats is important when opening files as well.  
 
The open dialogue: 

1. Click Computer then Browse for more options. 
2. There is a series of options in a drop list labeled Files of Type. 
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 The items that appear in the main viewing pane of the Open dialogue box will depend 
on the type of file that is specified in the Files of Type drop list. 

 If the file is to publish to the web, choose the All Web Pages option. This will restrict the 
files in the viewing pane to those with types that are suitable for the World Wide Web.  

 Use the All Files option to show all of the files in a given location. 
 

II. Upgrading a Workbook 
A book from an earlier version of Excel (Excel 97 to Excel 2003) can be converted to Excel 2013. 
 
To upgrade a workbook: 

1. Open Excel. 
2. Use the Open option to open the earlier (file extension .xls) workbook file. 
3. Click the File menu and choose Convert. 
4. Excel will show a warning. 
5. Press OK. 

 

 
 
Although converting workbooks is recommended (as it allows for the use of new features of 
Excel), it is also recommended that a backup be created before doing the conversion. 
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III. File Properties 
File properties are important for a number of reasons. The file properties can be used to get 
useful information about the file without having to open the file itself. Specific file properties 
can be entered to help maintain and manage files. Properties can be used as keywords when 
searching for a file. File properties can show the size of the file, the date the file was created, 
the date the file was last modified and what application is most appropriate for the file. 
 
To view the properties of a file without opening it: 

1. Right-click on the file icon in Windows Explorer. 
2. Select Properties from the menu. 
3. This will display the General tab of the Properties dialogue 

for the file. 
 

In the Properties dialogue box: 

 Edit the file name in the editable text field near the top. 
When Enter is pressed or OK is clicked, the file will assume 
whatever name is in the text field. 

                     
 

 A description of the file type and the program that is the 
default choice for opening the file. 

 
 

 Click the Change button to select another program to open the file with. If another 
program is chosen to open the file and the file is double- clicked, the file will be opened 
with the new program. 

 

 Information of the location of the file, the size of the 
file, the creation date, when the file was last 
modified and when it was last accessed is available. 

 
 

1. The two checkboxes at the bottom of the Properties 
box allow for the file to be Read-Only and Hidden. 

 
 

2. If a check is placed in the Hidden checkbox, the file icon will not be available when 
looking at the contents of the folder that contains it unless the option is enabled in 
Windows.  
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If a file is hidden: 
1. The file can be made visible by choosing the Tools menu in Windows Explorer 
2. Choose Folder Options from the menu bar in the folder that contains the hidden file.  
3. This will display the Folder Options dialogue. 
4. Under the View tab, select the radio button labeled, “Show hidden files and folders.” 

This will make any hidden files visible. 
 
If file is marked as Read-Only: 

 The file can then only be read, not written to. This means that if the file is opened and 
changes to the data are made, the file will have to be saved under a new name.  

 A message will appear if a Read-Only file is trying to be modified and saved. 

 
 
 
The Advanced button on the bottom of the General tab in the File Properties dialogue box, it will 
display an advanced attributes box: 

 
 

 In the advanced box, there are options to allow indexing of the file for better search 
performance, to compress the file to save disk space and to encrypt (encode) the file to 
help secure the data.  
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To edit/view file properties from within Excel: 
1. Open a workbook, and display the Office menu. 
2. Select the Info Tab. 

 

 
 

3. The properties are on the right side. 
4. Click the Properties text and select “Show Document Panel”  
5. Enter properties for the document. 

 

 
 

6. A small arrow labeled Document Properties will allow access to advanced options. 


